Using Cubase LE to record

Since Cubase LE is a product provided by
Steinberg Media Technologies GmbH, we do
not support it.

Please refer to the Cubase LE Help menu (and
PDF manual) for information about how to use
it.

Trademarks

Contents
Conventions used in this manual.........cc.ccevcenrueee 1
Trademarks 1
Recording with Cubase LE.........ccoemeeeesrnecrennnns 2
Preparation 2
Recording 5
Mixdown 5
Troubleshooting 6

Conventions used in this manual

In this manual, we use the following conven-
tions:
» Words that appear on the computer display
are shown in quotation marks like this: “OK”
 Additional information is provided as
necessary as tips, notes and cautions.

TIP
These are tips about how to use the unit.

These provide additional explanations and
describe special cases.

Failure to follow these instructions could
result in injury, damage to equipment or lost
recording data, for example.

D01193220A

» TASCAM is a registered trademark of TEAC

Corporation.

Microsoft, Windows, Windows XP, Windows

7,and Windows 8 are either registered

trademarks or trademarks of Microsoft

Corporation in the United States and/or

other countries.

* Apple, Macintosh, Mac OS and Mac OS X are

trademarks of Apple Inc.

Cubase and VST are registered trademarks

of Steinberg Media Technologies GmbH.

ASIO is a trademark of Steinberg Media

Technologies GmbH.

* Other company names, product names and
logos in this document are the trademarks
or registered trademarks of their respective
owners.
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Using Cubase LE to record

Recording with Cubase LE

The settings in Cubase LE are the same in
Windows XP, Windows 7, Windows 8 and Mac
OS X.

The screens in the example below are from
using a US-144MKIl with Windows 7.

Preparation

1. Launch Cubase LE and select “Device
Setup..."from the “Devices” menu.
P ——
Transport Window Help
MIDI Device Manager
Mixer F3

Plug-in Information
Record Time Max

VST Connections F4
VST Performance F12
Video Player F8
Virtual Keyboard Alt+K
Show Panel

Device Setup...

After starting Cubase LE, if the “Project
Assistant” dialog appears, click the “Cancel”
button at the bottom right to close it.

2. Click“VST Audio System” on the left side of
the “Device Setup” window. Set the “ASIO
Driver”item on the right to “US-122 MKII /
US-144 MKII".

VST Audio System

MIDt No Driver
© MIDI Port Setup
Transport ASIO DirectX Full Duplex Driver
Record Time Max
s foo_dsd_asio
= Video Player ¥ Generic Low Latency ASIO Driver
[ vsT Aucio Systen | TEAC ASIO USB DRIVER

Generic Low Latency ASIO Driver

VST System Link. US-122 MKII / US-144 MKII

US-366
US-600

W Activate Steinberg Audio Power Scheme

: 2

Adjust for Record Latency

Mutti Processing
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3. When the following dialog appears, click

the “Switch” button.
- CubsseLEG [

o
)
9 Do you want to switch the ASIO driver?

"

The following screen appears.

Device Setup
VST Audio System
Devices Us-12 144 MK [-] si0 Driver

MIDE
© MIDI Part Setup
Transport

M Release Driver when Application s in Background

Record Time Max Input Latency: 11,610 ms
Video OutputLatency: 5805 ms
R Video Player

75 v o yster] SRS

US-122 MKIL/ US-184 MK HW Pull Up/Down: off

VST system Link
Advanced Options et to Defauts

e
Multi Processing
M Activate Steinberg Audio Power Scheme

Adjust for Record Latency

4. Click”US-122 MKII / US-144 MKII” on the

left side of the “Device Setup” window
and confirm that the “I/O” ports are set to
US-144MKIl ports. Then, click “OK" to close
the window.

& Device setup

US-122 MKII / US-144 MKII
—— s FDm
T o
e
B Extemally Clocked
W Direct Monitoring
et Tsate |




Using Cubase LE to record

Select“VST Connections” from the “Devices”
menu.

Confirm that the “Device Port”is set to
US-144MKIl on both the “Input”and “Output”
tabs.

Close the dialog after confirming.

< VST Connections - Inputs

Tnputs | Outputs |

BEAI Add Bus. Presets | -]

Bus Name Goe  oea [Device Pa

=) E | stereo US-122 MK/ US-144 MK
o Left US-144 MKILanalog in L
- Us-144 MKl analog in R

Inputs page

¢ VST Connections - Outputs

Inputs | Qutputs |
HEAI Add Bus. Presets [N -|
B tame T e [Desce port TG |
Er ) BT stereo US-122 MK/ US-144 MK Cick
o Left US-144 MKI analog out
B rignt| US-144 VKT analog out

Outputs page

« To use the digital input and output of the
US-144MKiIl as inputs and outputs for Cubase
LE 5, add the digital input and output on the
Input and Output tabs of the “VST Connec-
tions” window.

* Click the “Add Bus” button.

» When the following dialog appeatrs, set
the Configuration to “Stereo” and the
Count to “1” and then click the “OK”
button.

4= Add Input Bus {ﬂhj
Configuton Confgreion
LR LR

[0k 1 cancel | [T ok 4| Cancel |

«+ Add Output Bus ]

The windows should appear as follows
and the digital input and output should be
available for use.

<+ VST Connections - Inputs

Inputs | Outputs |
BE Al Add Bus Presets [N -|
Bus Name. [ speakers | Audio Device | Device Part |
E-d) Stereoln | Stereo US-122 MK/ US-143 MK
o Lett US-144 MKI analog in L
o Right US-144 MK analog in R
£ sterco 1n 2 T Us-122 MK/ US 144 MK
o Left US-144 MKI digital in |
o Right US-144 MKI digital in R

Inputs page

< VST Connections - Outputs

Inputs | Outputs |
@E Al Add Bus Presets [N -]
R e e TDevice Port ek |
) Stereo Out sterco Us-122 MK/ US-144 MK Gliek
-0 Left US-144 MKl analog out

=3 US-143 MKI analog out
Stereo Out 2 | Stereo US-122 MKIL/ US-144 MK
—o US-143 MIKI digital out |

-0 Right US-144 NI digital out F

Outputs page

» The number of buses that can be used at the
same time in Cubase LE is limited. Refer to
the Cubase LE Help menu (and PDF manual)
for detailed information.
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Using Cubase LE to record

Select “New Project..”” from the “File” menu,
and select the template you want from the
“Project Assistant” dialog.
s

=)

@ g o

Production Mastering More

Acoustic Guitar + Vocal

Clean E-Guitar + Vocal

Distortion Guitar + Vocal

Piano + Vocal

Stereo Acoustic Guitar

» Depending on the selected template, a
“Missing Ports” dialog might appear. If it
does, click the word “Unmapped” in the
“Mapped Ports” column, and select the port
you want to assign from the list that appears.

X Missing Ports
Missing Ports |40 | Mappea ports | Map Aways |
% Wicophone (igh Definion 1 In Unmappect
B & Micophone (igh Defintion 2 In Unmappect

Missing Ports/Unmapped

T wissing Ports

Missing Ports 140 | Mappedports | Map avways |
- Microphone (High Definition 1 In Unmapped
# Microphone (High Definition 2 i [77] Not Connected

US-144 MK analog in L
US-144 MKII analog in R
US-144 MKII digital in L
US-144 MKII digital in R

Missing Ports/selecting from menu

X Missing Ports

Missing Ports | V0| Mapped Ports | Map Aways |
w P L
@ o [OAGIGENITE I US14 MKIonsloginR

Missing Ports/after port selection
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* Ifyou select the “Empty” template from the
“More” page, use the “Add Track” item in the
“Project” menu to add audio tracks.

¢ Cubase

Fle Edt (Project] Audo MIDI Media Transport Devices Window Help
e Add Track g

W Instrument.

= mL.

Duplica
Remov
Remove Empty Tracks

d Tracks Shift+Del

] Using Track Preset ...

Show All Used Automation 3 P Charnel..
Hide All Automation & Folder

pool Ctrisp | ' Group Chamnel..
Markers Cotem | Iz Marker

Tempo Track CirleT | 3 Ruler

Beat Calculator... I Video

Set Timecode at Cursor..

Notepad

Project Setup. Shifts

Auto Fades Settings...

TIP
When recording a vocal or an acoustic guitar,
for example, with a single microphone,
create and record to a mono track.
When recording a piano in stereo with two
microphones or recording a keyboard or
similar device using the stereo line input,
create and record to a stereo track.
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Recording

1. Select the track that you want to record to,
and set the input bus in the “Input Routing”
field on the left side of the window.

Fle Edit Project Audio MIDI Media Transport Devices Window Help

~ B
e m =)
oo 0 I Audio03
()[R u]

o P I Autioos
oo

I Audio 05
oo M

No Bus

Stereo In » Vo Left
»| o Right

Press the m{(“Monitor”) button if you want to
hear the input signal.

2. After you have completed setting the input
buses for every track, click the @ (“Record
Enable”) buttons (making them red) for the
tracks that you want to record on.

File Project Audio MIDI Media Transport Devices Window Help
6 hours 09 mis adkdz-24

(22l n [ s P70
(O rluf

(Sl n [ s PP
ol

3. Pressthe @ (“Record (Pad*)") button in the
transport section to start recording.

4. When you finish recording, press the
M (“Stop (Pad0)”) button, then click the
@ (“Record Enable”) buttons to turn it off
(the button indicator will turn off). Rewind
if necessary.

5. Repeat steps 1-4 to overdub additional
tracks.

Mixdown

1. Move the left and right locators to specify
the region that you want to mix down.

2. From the“File” menu, choose “Export” >

“Audio Mixdown".

File| Edit Project Audio MIDI Media Transport Devices Window Help

New Project...
Open...

Close

Save

Save As...

Back up Project...
Save as Template...
Revert

Page Setup

Print...

Import

Export

Preferences...
Key Commands...

Recent Projects

qQuit

Replace Audio in Video File...

cerl+N
Ctrl+0
crl+w

Ctrl+s
Ctrl+Shift+S

ctri+Q

MIDI File...
MIDI Looy
Audie Mixdown...

Notepad Data...
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Using Cubase LE to record

3. Inthe”Export Audio Mixdown” dialog box,
make the desired settings, then press the
“Export” button.

Export Audio Misdow] =

oo PR Wono Downic
T o SoRCharnd 3o 01 ey’ +

W Rl Time Bport U Chomnets

[

W Close Window ster por. B Ut Display

.

On this screen, set the File Name, Path
(location where saved), File Format, Sample
Rate, Bit Depth and other attributes of the
file to be created.

4. A window like the following appears while
the file is being created.

After the file has been created, press the Close
button on the “Export Audio Mixdown” window
to close it. The mixdown file is saved according
to the settings made in step 3.
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Troubleshooting

This chapter answers frequently asked
questions related to recording with Cubase LE.

Q1. Ithink | have configured the input settings
properly, but | see no activity on the audio
track’s meter.

A1. Make sure that the Monitor button of the
track is enabled.

Q2. I would like to record two channels simul-
taneously in stereo.

A2. Before you record, choose Stereo track(s)
or add Audio track(s) as Stereo.

If the project does not have a stereo track,
select “Project” menu > “Add track” >
“Audio” and create the number of stereo
tracks that you need.

TR | ==

Add Track

When set as a stereo track, “Stereo In” or
something similar will appear as the input
as shown in the illustration below.

Cubase LE

e B als) 5

&= @@ (Rlu]
[sirlu]
(4




Using Cubase LE to record

Q3. Iam trying to use the EQ, but it does not
seem to do anything.

A3. Confirm that one or more EQ switches are
on in the EQ section for the channel in the
Inspector.

EQ OFF EQON

Q4. | tried to mix down a three-minute song,
but could mix only ten seconds.

A4. Make sure that the region specified by
the left and right locators is set to three
minutes or longer.

Q5. | cannot set the locator region to more
than a certain length.

A5. From the “Project” menu, choose “Project
Setup..”and then change the “Length”
field.

Cubase LE
File Edit Audio  MIDI Media Transport Devices
Add Track - B
r
Duplicate Tracks i
Remove Selected Tracks shift=Del

Remove Empty Tracks

Show All Used Automation
Hide All Automation

Pool ctri+p
Markers Ctri+M
Tempo Track Ctri+T

Beat Calculator...

Set Timecode at Cursor....

Notepad

Project Setup... Shift+S
Auto Fades Settings...

< Project Setup =
I o ‘

e
0:00:00:00 5213

e BT Lo

Frame Rote. e ram vides ‘

Oipiy Forre

Ol Ot
| o EEeES

Samplrite
C——pr

Equal Power [ <] Stereo Pan Law

[ Hep | [ ok ][ cancal
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Q6. | burned a CD using the WAV file | mixed
down, but the speed is obviously different.

A6. Could the sampling rate of your project be
set to 48 kHz? If your ultimate objective is
to create a CD, TASCAM recommends that
the sampling rate be set to 44.1 kHz from
the beginning.

To specify the sampling rate, choose
“Project Setup..” from the “Project” menu,
then set the sampling rate to “44.100 kHz".

¢ Project Setup et

- ‘

Company

Strt
Length
Fiame Rate |_Get rom video | ‘

ottt

>

248t =] B Resolution

e
e Pt

[ tep ) [ oc J[ conce

Q7. I have connected an audio source to the
Unit, but cannot hear anything.

A7. Make sure that the input level of the
audio interface is raised appropriately.
When a signal is being input, the signal
indicator of the audio interface will light
up green. Make sure that the monitor (or
headphone) level is raised, and that the
connections are correct.

Q8. The sound is distorted.

A8. Make sure that the signal is not
overloading. If the signal is analog, the
ideal level is when the overload indicator
lights up red occasionally.
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